
ALSO INSIDE
Member News, Meetings  2
Blackwell Gallery, Photo Fest  3
EID and Travel Inter-Club Contests  3
Favorite Place by Madelaine Cornelius 4
2009 PSC Annual Honorable Mentions      5
March Quarterly Contest Rules  5
Digital Q&A, Members’ Corner  6
Converting Color to B/W, Slide Film News 6
PSC Calendar, Non-PSC Opportunities 7

Favorite Place - Page 4

February 2010
Volume 60, Issue 2

PSC MEETING 
featuring 

CRAIG TANNER 
Thursday, February 18

Visitors Welcome!
 6:00 pm - Refining Exposures
 6:30 pm - PSC Meeting

                          East Ridge Community Center

“MAGIC OF DIGITAL NIGHT PHOTOGRAPHY”
Craig Tanner is a location advertising photographer, film maker 
and widely acclaimed photographic educator. In his career as a 
landscape based advertising photographer Craig has produced 
stock and assignment photography for many clients including Ko-
dak, Delta, Adobe, Arvida, Georgia Tourism, and the Jack Nick-
laus Development Corporation. Craig’s photographs have ap-
peared in numerous national  and regional publications including 
Backpacker, Outdoor Photographer, Outside, Southern Living, 
and Atlanta Magazine. Since 1992, Craig’s large format color 
landscape photography has been exclusively featured in over 
twenty-five calendars and in the book Georgia, published by 
Graphic Arts Center Publishers.
In addition to his editorial  and advertising photography, Craig’s 
fine art landscapes are widely collected and exhibited and can be 
found in the corporate collections of The Coca Cola Company, 
Cox Communications, The Home Depot, Southern Company, and 
UPS.
Craig is also a prolific  photographer of people and specializes in 
impromptu street portraits of the people he meets during his trav-
els. Craig’s work exemplifies how the use of light, rhythm, color, 
and emotional  connection with the subject can bring out the beau-
tiful and timeless qualities of a person, place or moment.
One of Craig’s most ardent passions is teaching. Craig has be-
come widely recognized as a dynamic and inspiring speaker, 
teacher and workshop leader. Craig is the founding contributor of 
The Mindful Eye, one of the web’s finest resources for photo-
graphic education and inspiration.

YOUR EMAIL ADDRESS IS IMPORTANT
Email  is a convenient way for the PSC to keep members apprised 
of schedule changes for PSC activities, meeting reminders, and 
other photographic  opportunities of benefit to members. Please 
remember to keep your email  address current by reporting 
changes to Janis Rowland at stringfree@aol.com or at meetings.

YOU ARE INVITED
to

FEBRUARY PSC SOCIAL
6:30 pm

Monday, February 1
Hamilton Place YMCA
Guests Are Welcome

Members are  asked to bring a snack or 
appetizer. Drinks, ice and paper goods 
will be provided by the Board.

http://www.tmelive.com/
http://www.tmelive.com/
mailto:stringfree@aol.com
mailto:stringfree@aol.com
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January Visitors
 Matt Boescher  Amie Dodson
 Kent Goodner Jeff Schwenke
 Lila Sherrill  D. T. Trischler

New Members
 Ed Blevins Rick Fairbanks
 Kimberly Graves Kate Haley
 Bob Hudson Pam Ogden
 Christy Shoemaker  Evelyn Wall

NEXT DIGITAL COMMITTEE
6:30 PM - Thursday, February 4

(1st Thursday of each month)
Bob Bratton: bratton@bellsouth.net 

NEXT PSC BOARD MEETING
6:15 PM - Thursday, February 25

John Jackson, President
artmaster6547@yahoo.com 

PSC Board and Digital Committee meetings are 
held in the JC Penny Hamilton Place 2nd floor con-
ference room and are open to any members who 
wish to attend. Board and Digital  committee mem-
bers are asked to email  their chairman if unable to 
attend the meeting.

New	
  Member	
  Corner:
Meet	
  Ed	
  Blevins

By	
  Pat	
  Gordy

Welcome to one of the 
newest members of PSC, 
Ed Blevins who joined at 
the January reception at 
the Gallery at Blackwell’s. 
Although Ed grew up in 
Chattanooga, he has 

lived most of his life in 
California (San Francisco and Santa Rosa). He 
returned to the Chattanooga area because of his 
Dad’s illness. Spending five years as a digital pho-
tographer of portraits and nature, Ed owns Nikons 
D50, D200, D300S, and D3X. In addition to pho-
tography, Ed enjoys bike riding, and he averages 
100 miles of riding per week.

Member News

CONGRATULATIONS! 
• Mark Wurst has a publication credit in the March 2010 issue 

of Trains Magazine.

• Seth Shaffer has a photo exhibit at the McKee Library at 
Southern Adventist University.

• Dan Jeter’s Stormy Sunrise (People’s Choice and 2nd place 
in PSC’s 2009 Annual Contest) continues to win him awards 
in other competitions. Recently, Dan’s  Stormy Sunrise took 
an Honorable Mention in the Mississippi Valley Salon of  
Photography, sponsored by the St. Louis Camera Club. Go 
to www.stlcameraclub.com/mvs2009/images/web/sect_1.htm 
to view his and other winners and acceptances. Stormy Sun-
rise  also won Honorable Mention in the January EID Inter-
Club Competition for Group 1. This was the only image from 
southeastern USA members to place in the competition. 

• Dr. Cauley Hayes was honored at "The Seventh Annual 
Baroness Erlanger Foundation Distinguished Physician 
Brunch" on January 30, 2010, along with two other doctors. 
The three individuals were honored for their unquestionable 
character, as well as their commitment and excellence in 
medicine to the region's medical  community. Dr. Hayes is 
currently Professor of Plastic Surgery and Director of Re-
search at Erlanger. He also founded the Hayes Hand Center 
and Chattanooga Hand Rehabilitation Center. He was direc-
tor of The Plastic Surgery Group for nearly 40 years.

• Pat Gordy became a graduate of the PSA Image Analysis 
Course in January. She also presented a program on judg-
ing and PSA to the Cookeville Camera Club on January 25.

• Roelf and Maralese Steyn are celebrating the birth of their 
son Marcus on January 16. I’m sure Dad will have pictures to 
share with all at the February meeting!

• Bill and Beate Mueller are 
celebrating the birth of their 
first grandchild in Asheville. 
Olivia, pictured here, arrived 
January 19 weighing in at 6 
lb. 9 oz. and 19.5 inches 
long. Beate will  be after NC 
to complete I-40 repairs to 
make faster trips to see her.

HEALTH
• Pat Gordy is home continuing to recover from her gallblad-

der surgery and having more tests. 

• Gene Cornelius had more melanoma surgery in January 
and is recovering nicely at home.

• John and Chrissy Jackson are both having health issues. 

SYMPATHY
• Dave Rhinehart’s father passed away January 15 after a 

short hospital stay. Our thoughts are with Dave and his family 
during this time of sorrow.

mailto:bratton@bellsouth.net
mailto:bratton@bellsouth.net
mailto:artmaster6547@yahoo.com
mailto:artmaster6547@yahoo.com
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PSA EID Inter-Club Contest 
By Milton McLain

Results are in on the January Electronic Imaging Division 
competition and the next due date announced. Dan Jeter 
received an Honorable Mention (12 points), Milton McLain 
10, Bill Mueller 9, Mike Williams 7, Mohan Rao and Dr. 
Cauley Hayes 6. Our club is in 16th place out of 21 clubs. 

Entries for the next round must be in by February 26 and 
the same rules apply. Hope you send me some really com-
petitive images at miltsmail2@bellsouth.net. Contact if you 
have any questions. 

PSA Travel Inter-Club Contest 
By Bill Mueller

Everybody’s been someplace, so dig out those travel im-
ages you are proud of and tighten them up for the next 
round in the Travel competition. Send your mages for 
the next PSA Travel Inter-Club Competition to Bill 
Mueller at shooter@gate.net by February 12.
Images must be submitted as JPEG images and an 
sRGB color space is recommended. Maximum image 
width is 1024 pixels and maximum height is 768 pixels. 
Each image should have maximum file size no greater 
than 800K. Each club is limited to six entries by six differ-
ent members. You do not have to be a member of the 
Photographic Society of America to enter, just a member 
of PSC.

Contact Bill Mueller if you have any questions about the 
competition.

The Gallery at Blackwell
“Spring Awakenings” 

The next gallery changeout will be February 25-26, 4-6 pm 
at Blackwell  Automotive, 71 Eastgate Loop, Eastgate Mall. All 
PSC members are invited to participate. The theme is Spring 
Awakenings - to challenge your imaginations; but photo-
graphic works of all types are welcome. This exhibit will 
run March 1 to June 30.  

Prints must be appropriately framed for sale - 8x10 or larger 
with hanging wires on them.

Additional  details for Gallery at Blackwell  entries are posted 
on the PSC website at chattanoogaphoto.org. 

The current gallery images are some of the best I’ve ever 
seen there, so I’m looking forward to more.

WHAT IS PHOTO FEST?
By Janis Rowland

This year marks the 3rd Annual PSC Photo Fest. But 
what exactly is Photo Fest? It is the only all-photography 
art festival in Chattanooga and is held each April  on Sat-
urday indoors at Heritage House in East Brainerd's Heri-
tage Park. This is your day to showcase your photogra-
phy for the public. In the process, you may even sell a 
few pieces or learn something from the mini seminars 
presented by fellow PSC members throughout the day. 

It is likely that over 100 people will  pass through the 
doors but it doesn't take a large investment to prepare for 
the event. Show one piece or 100 pieces. It is recom-
mend that your pieces be shrink-wrapped if they are mat-
ted, and that note cards be housed in cellophane enve-
lopes to avoid damage. They may be displayed on table-
tops, in a rack for matted prints, or in a spinner rack for 
cards. Framed pieces will show on wall hangers, on wire 
free-standing racks, against the wall on the floor, or on 
tabletops. Please note that personal display equipment 
will  not be allowed without prior approval. Tabletop dis-
play devices are the exception. 

The Photo Fest Committee needs members to do the 
preliminary, behind the scenes work. Volunteers are 
needed on the day of the festival to present mini-
seminars (approximately 6 for 30-minute sessions); help 
get the exhibits in; set up; greet visitors; man the PSC 
welcome center; work in the concession area; set up the 
seminar area; and help clean up at the end. If you can 
help in any of these areas, please contact Janis Rowland 
at stringfree@aol.com or 894-7112.

Come and experience Photo Fest. At the very least, you 
will  spend the day with like-minded people and talk about 
your favorite subject (photography.) Concessions will  be 
available for purchase and complimentary live music will 
be on hand to draw a crowd.

Gallery at Blackwell Tips
There are guidelines for submitting pictures to the gallery 
that we have periodically published, but some things seem to 
be falling through the cracks. Our gallery is for sale quality 
pictures that are desirable to the public and meet standards 
of art galleries. They also should represent our club well.

In order to be hung satisfactorily there or in a customer’s 
place a hanging wire is required. It’s usually installed 1/3 the 
distance from the top.

Framed prints should be matted. This is not just for appear-
ance. It prevents the print from being in contact with the 
glass, which can cause sticking problems. Gallery wraps and 
other formats can be used if desired.  

Mats must be cut in a professional manner or they look ama-
teurish. That means no rough edges and no overcuts.  Like-
wise frames should be professional quality.  

Questions are welcome.

   Milton McLain, Curator

mailto:miltsmail2@bellsouth.net
mailto:miltsmail2@bellsouth.net
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Favorite Place: 
Chattanooga National Cemetery 

By Madelaine Cornelius
The Chattanooga National Cemetery is a very special and sacred place, 
and has been covered with a wonderful  piece by Ed Bowen several years 
ago, but since we have so many new members, I decided to share my feel-
ings about this beautiful cemetery. I love to visit, contemplate and record the 
peacefulness that permeates this hallowed ground and the patriotic cere-
monies and events that take place in the different seasons. The park-like 

setting includes 121 acres of land, which holds the remains of veterans from the Revolutionary 
War to the Gulf War and 186 graves of German prisoners-of-war from both World Wars. As of 
2008, there are 46,601 interments.

On a hill  in the center of the cemetery are four canons facing the sky. At the bottom of 
the hill is a large Roman-inspired arch, approximately 35 feet high with Doric  col-
umns, a pair of ornamental iron gates, and inscription above. Behind the arch is the 
memorial honoring those who served in each branch of service. It was here that the 
Wreath-Laying Ceremony took place in early December of 2009. The Civil Air Patrol 
and the Daughters of the American Revolution played an important role in this im-
pressive ceremony honoring all  the men and women who have served our country. 
Attending this event was a gift to myself.

The cemetery has the graves of six Medal of Honor winners, men who were captured 
and hung by the Confederates for their role in the Great Locomotive Chase. The Ohio Monument is a tribute to these first 
awardees of the Medal of Honor, and contains a replica of The General. It is among the most unique memorials in the 
cemetery.

For Memorial Day all the graves are decorated with an American Flag and this is awe-inspiring to witness. Several  of our 
friends are buried here and I photographed their burial places for their families on this day of remembrance.

Years ago the “Moving Wall” visited the Chattanooga National Cemetery. It 
is a half-sized replica of the Vietnam Veterans Memorial that is found in 
Washington D.C. and is dedicated to those who served in the Vietnam 
War, both living and dead. When a visitor looks upon the wall, his or her 
reflection can be seen simultaneously with the engraved names, which is 
meant to symbolically bring the past and present together. Some people 
leave sentimental items for their deceased or missing loved ones. Those 
who could not travel to Washington D.C. had the opportunity to see and 
touch the names of friends or loved ones thanks to Veteran John Dewitt, 
who vowed to make a transportable version. By 2006, there had been 
more than 1000 hometown visits of the “Moving Wall.”

Anytime is a good time to visit Chattanooga National Cemetery. One will 
always be touched by its beauty, meaning, arrangement, and architecture. 

Different seasons, different weather conditions, different times of day and various celebrations will  give the photographer 
opportunities and challenges and a memorable experience.
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HM Advanced Print by Tim Solomon

2009 PSC Annual Contest Honorable Mentions

MARCH QUARTERLY CONTEST - “CURVES”
  1. The Quarterly Contest is open to members in good standing (current dues paid).
  2. Slides, prints, and digital images will be judged together as one competition.
  3. A maximum of two entries can be submitted by each member.
  4. Prints must be at least 5x7 inches, mounted (matting is optional). The participant’s name must appear on the back.
  5. Slides must be marked with the participant’s name on the back side. A registration dot must be placed in the lower 

left corner of the mount (Hold the right side of the slide to ward you and place the dot in the lower left hand corner). 
Slides are to be placed in the tray upside down with the correct side facing you. This puts the dot where it can be 
seen from the right hand side of the tray. No glass slides allowed.

  6. Digital images must be in JPEG format, either saved to a CD and brought to the February PSC meeting or 
emailed by February 25 to Tim Solomon, timsolomon48@yahoo.com. This will give the digital committee time to 
organize all digital submissions for screen presentation on the night of the contest in March. 

  7. Save the file using your first and last name and the number of your submission (#1 or #2). To insure the proper image 
size and quality for judging, the image file size should be 100 kb minimum and 350 kb maximum. The required maxi-
mum horizontal dimension is 1024 pixels and the maximum vertical dimension 768 pixels.

  8. Slides, prints, or digital  images which have previously won prizes in an Annual  Contest or ribbons at quarterly compe-
tition cannot be entered again.

  9. The judge is not eligible to participate.
10. Quarterly Contests are independent of the Annual Photo Competition held in December. Slides and prints entered in 

the Quarterly Contests may be entered in the annual competition.

HM Amateur Print by 
Connie Thompson

HM Amateur Print by Rosemary Williams

HM Advanced Print by 
Leslie O’Rear

HM Amateur Digital by Gordon Calhoun

HM Advanced Digital by Angela Dillard HM Amateur Digital by 
Russell Robards

HM Advanced Digital by Seth Shaffer

HM Advanced Digital by 
Madelaine Cornelius

HM Amateur Digital by 
Mel Aragon

HM Advanced Digital by Ken Stuart

mailto:timsolomon48@yahoo.com
mailto:timsolomon48@yahoo.com
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MEMBERS’ CORNER
Shari Vann would like a ride and a roommate to the Rocky Mountain School  of Photography weekend 
February 27-28 in Atlanta. See page 7 for details of the weekend. If anyone can provide either, please 
contact Shari at photobugshari@charter.net or call at 423-488-3129.

Epson 1280 Printer - good condition, rarely used, all  components and ink for $125 or best offer. Contact 
Kelly Lewis at 423-894-4081 or email her at sweetcreekphoto@yahoo.com.

Members, email psceditor@bellsouth.net with your item, query, comment. Include info and contact informa-
tion if response is needed. If you prefer not to have your name published, indicate this and the contact per-

son will be the editor. As responses come in they will be routed to you. 

DIGITAL Q&A - 57 
By Art Hansen

Question: I have heard and seen 
quite a bit about HDR. From what I 
have seen and heard we can’t pro-
duce a really good image unless we 
use HDR. I have seen quite a few nice 
images that were produced before 
HDR existed. What is the truth? Can 
we turn out really good images with-
out using HDR?

Answer: Well, here comes another “it depends” response. 
We first need to reach an acceptable definition for “a really 
good image” and we will not find it easy to define what con-
stitutes a really good image in the minds of everyone. In this 
case HDR is intended to provide a way to provide good ex-
posures for both highlight and shadow areas. Many people 
feel that this is very necessary for quality photographs. For 
these folks HDR does offer some real benefits. However, 
there is one issue here. HDR requires multiple in camera 
images, which are then blended into a single HDR image. All 
of the original  images must be identical  except for the expo-
sure used. Therefore, a moving subject cannot be used as 
an original in camera image. People, animals and other 
moving subjects cannot, therefore, be considered prime sub-
jects for HDR images.

WAYS TO CONVERT A COLOR PHOTO 
TO BLACK & WHITE

By Janis Rowland
Black and white photographs are coming into vogue 
once again. Digital imaging makes the task of con-
verting color to black and white easier than ever be-
fore. Some cameras even have a black and white 
setting. But it is generally agreed upon that flexibility 
lies in shooting color images and converting them 
rather than shooting black and white solely. 

There are many ways to make a suitable conversion 
using digital imaging software such as Adobe Pho-
toshop. 

One way to produce a black and white image (using 
Adobe) is to open the image; create a new layer; fill  it 
with pure black color; and change the type of the 
new layer to Color. A second method is to simply 
change the Mode from color to Grayscale. Equally as 
easy is the method of using the Image>Adjustment 
command Desaturate. Thirdly, you may want to de-
saturate the image by us ing the Image> 
Adjustment>Hue/Saturation and change the "satura-
tion" slider to -100. Experimenting with changes in 
contrast in each case may give you the striking black 
and white image you are seeking.

One more way (but not the final method) to make the 
conversion will  be discussed here. Open a color im-
age; create a second Hue/Saturation Adjustment 
layer through the icon in the Layers palette (or by 
us ing Layer>New Adjus tment Layer>Hue/
Saturation); and remove all color from the image by 
setting the Saturation slider to -100. Select the back-
ground layer once again; create a second Hue/
Saturation Adjustment layer between the background 
and the first layer; and set the layer blend mode to 
Color on this new layer. Clicking on the Layer 
Thumbnail reopens the Hue/Saturation dialogue box. 
Adjusting the Saturation slider gives you control over 
the final image. By saving the adjustment layers, you 
may return to the image to adjust it even further in 
the future.

You may find that no one method gives you the de-
sired outcome every time. The method that you use 
may vary depending on the image so keep these 
methods in your tool bag. 

SLIDE FILM STILL ON THE MARKET
By Janis Rowland

Good news for slide film shooters, slide film continues to be 
manufactured and is still available. One Fuji representative 
reported that because Europe is behind the curve on con-
version to digital imaging, film continues to be in demand. As 
long as demand continues, film will be available on the US 
market. 

Slide film is available from Internet websites that include  
Adorama (www.adorama.com) and B&H Photo Video 
(bhphotovideo.com) in New York as well as other photo 
websites. If you see a deal that is too good to be true, verify 
the expiration date on the film. 

Also, when comparing prices be sure to compare the 
shipped price to get the best deal. The shipping and han-
dling cost will vary from company to company.  

http://www.adorama.com
http://www.adorama.com
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PSC CALENDAR
FEBRUARY

 1 6:00 pm PSC Social at Hamilton Place YMCA
 4 6:30 pm Digital Committee Meets
12     PSA Travel Image Entries Due
18 6:00 pm Digital Mini-Tutorial
 6:30 pm PSC Meeting - 
25     NEWSLETTER ARTICLES DUE
25  6:15 pm  PSC Board meeting
    March Quarterly Contest Entries Due
    PSA EID Entries Due
25-26   Blackwell Gallery Pickup and Drop-off

MARCH
 4 6:30 pm Digital Committee Meets
18  6:00 pm Digital Photo Evaluation session
 6:30 pm PSC Meeting
25     NEWSLETTER ARTICLES DUE
25     PSC Board meeting

Non-PSC Opportunities
February 16-21: 
 Nature Photography Summit, Reno, NV
 Rocky Mountain School of Photography - 
 Use PSC discount code CC113 when registering
 Details www.rmsp.com/weekends or 1-800-394-7677

February 27-28: 
 RMSP Weekend, Atlanta, GA
 NANPA (North American Nature Photography Assoc.)
 Details & info about this event: www.nanpa.org

March 13 - 19: 
 Savannah/Tybee Island, Georgia
 Don McGowan
 Details for this and his other 2010 Workshops 
http://earthsongphotography.com/newSite/workshops.html

March 28-April 2: Calloway Gardens, Georgia
 Mark Johnson & Charles Needle
msjphotography.com/workshops/callaway_2010_flyer.pdf

April 7-10: Atlanta Botanical Garden
 “Creative Macro Photography Intensive” Workshop
 Charles Needle
 Details: www.charlesneedlephoto.com/workshops

April 29-May 2: NANPA Spring Regional Event
 Western North Carolina - details soon www.nanpa.org 

July 25-30: Butchart Gardens (Victoria, Canada)
 Mark Johnson & Charles Needle
msjphotography.com/workshops/Butchart_Gardens_2010_flyer.p
df 

September 13-18: Maine Coast & Acadia Nat’l Park
 Larry Winslett  Details:  www.larrywinslett.com 

RMSP WEEKEND
By Janis Rowland

The Rocky Mountain School  of Photography is coming to 
the Doubletree Hotel  Atlanta Airport in Atlanta on February 
27-28, 2010. The weekend event includes ten classes to 
choose from, a professional critique session and great 
door prizes. Classes are suitable for beginner through in-
termediate amateur photographers (film and digital media).

PSC members are invited to attend at a special rate of 
$159 for two days or $199 for one day. Use the PSC group 
code CC113 when registering at www.rmsp.com/weekends 
or call 1-800-394-7677.

Email Janis at stringfree@aol.com if you plan to attend.

FOR SALE: Epson 7880 Printer
David M. Rutledge has an Epson 7880 eight color printer 
(purchased about 1.5 years ago) that will hold up to 24” 
rolls . He decided to use his Epson 4880 for his business 
needs and no longer has a need for the Epson 7880.
It is virtually unused. The 7880 has only been used to print 
about 10 photographs since purchased. Harvey Head 
Cleaner software is run every day to keep the heads clean. 
The printer has Epson 220ml cartridges approx. ¾ full  and 
1 roll  of partially used 24” semi gloss Epson photo paper 
that goes with it.
The printer is priced at $1500.00. Anyone interested, can 
reach David at 931-456-9631 or 931-248-1940 or email 
him at drutledge@stagecoachplace.com.

FIELDTRIPS
Do you know of a great location or activity for a photo 
shoot? Then let us know. It is time to plan PSC fieldtrips 
and photo destinations for 2010. Email  James Adams at 
james_adams2@comcast.net with your suggestions. 
We are always looking for new locations and ideas. 

MARK YOUR CALENDARS

February 12 PSA Travel Competition
February 25: March Quarterly Contest-Curves
February 25: PSA EID Competition
February 25-27: “Spring Awakenings”
  Gallery at Blackwell Exhibit
April 24: PSC Photo Fest at Heritage House

Details on page 3 and PSC website

http://www.rmsp.com/weekends
http://www.rmsp.com/weekends
http://www.nanpa.org
http://www.nanpa.org
http://www.msjphotography.com/workshops/callaway_2010_flyer.pdf
http://www.msjphotography.com/workshops/callaway_2010_flyer.pdf
http://www.nanpa.org
http://www.nanpa.org
http://www.msjphotography.com/workshops/callaway_2010_flyer.pdf
http://www.msjphotography.com/workshops/callaway_2010_flyer.pdf
http://www.msjphotography.com/workshops/callaway_2010_flyer.pdf
http://www.msjphotography.com/workshops/callaway_2010_flyer.pdf
http://www.larrywinslett.com
http://www.larrywinslett.com
http://www.rmsp.com/weekends
http://www.rmsp.com/weekends


BOARD MEMBERS OF THE PHOTOGRAPHIC SOCIETY OF CHATTANOOGA 
OFFICERS

President  John Jackson 423-591-2916 artmaster6547@yahoo.com
President-Elect  Mark Wurst  423-605-0375 mark@mswphoto.com
Secretary  Pat Gordy  423-718-7552 patgordy@bellsouth.net 
Treasurer Janis Rowland 423-894-7112 stringfree@aol.com 

DIRECTORS
James Adams  (2010) 423-645-5145 james_adams2@comcast.net 
Rodney Blum  (2011) 423-892-2187 rodneyblum@att.net 
Johannes de Wet  (2012) 423-298-2923 johannesdewet@gmail.net 
Joni Fisher  (2011) 423-892-5966 jbf0258@aol.com 
Sara Haase  (2010) 423-892-3381 sarakeinh@hotmail.com 
Dan Jeter  (2010) 423-875-3348 dpjeter@yahoo.com 
Bill Mueller  (2012) 423-504-4026 shooter@gate.net 
Roelf Steyn (2012) 423-488-3869 roelfus@bellsouth.net 
Connie Thompson (2011) 423-899-7299 cdtcpa@aol.com  

WEBMASTER: Mickey Rountree webmaster@chattanoogaphoto.org

Editor Contact Information
Mary McLain, Editor
5720 Vincent Road

Chattanooga, TN 37416
Fax: 423-344-9032

psceditor@bellsouth.net

PSC Membership Dues
(Effective October 1, 2009)

   Full-time Student: $15
   Single Membership: $25
   Family Membership: $30

Monthly Meeting Information

Day: 3rd Thursday Each Month
Time: 6:30 Social and 7:00 Program

Location: East Ridge Community Center

Located at 1517 Tombras Avenue: From 
the intersection of I-75 and I-24, follow I-
24 toward downtown. Exit at Moore Road. 
Go to Ringgold Road and turn right. Move 
to the left lane and turn left on Tombras 
Avenue at traffic signal #8. Turn right into 
the third driveway.

The Photographic Society of Chattanooga 
holds club membership in Photographic 
Society of America, Allied Arts of Greater 
Chattanooga, Americans for the Arts, and 
Tennesseans for the Arts.

Photographic Society of Chattanooga
P.O. Box 8886
Chattanooga, TN 37414

A not-for-profit organization
Website: www.chattanoogaphoto.org
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